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Intro When extremely high-temperature and/or high-pressure viscosity measure-

ments are required, the OFITE HTHP viscometer is the solution.  This fully-

automated system accurately determines the rheological properties of com-

pletion fluids and drilling fluids in terms of shear stress, shear rate, time, and

temperature at pressures up to 30,000 PSI (207 MPa) and temperatures up

to 500°F (260°C).  An optional chiller is available for those situations in which

the fluid sample needs to be cooled, rather than heated, further increasing

the flexibility of the system.  

Like OFITE’s other computer-controlled viscometers, the HTHP Viscometer

features our easy-to-use ORCADA™ software.  Using this exclusive soft-

ware, a computer novice can operate the HTHP Viscometer, and yet the sys-

tem is versatile enough for advanced research and demanding test parame-

ters.  

The HTHP Viscometer uses a compass to detect the rotation of a magnet at

the top of the torsion assembly. The influence of the powerful drive magnets

inside of the shield, the earth's magnetic field, the magnetic properties of the

shield, spring non-linearities, magnetic fields and masses in the laboratory,

non-ideal fluid flow, and small geometry variations all combine to make the

angle display non-linear if not compensated. The microprocessor allows for

easy compensation for those effects.

Your HTHP Viscometer has been shipped with everything you need to begin

testing. It includes a computer with all necessary software already installed. 
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Components #120-00-016-1 Pressure TDR; 50,000 PSI (344.8 MPa)

#120-106 High Pressure Filter

#130-75-71 PC Monitor

#130-75-74 Desktop Computer

#130-76-04 Main Bearing; Qty: 2

#130-76-05 Retaining Ring

#130-76-06 Drive Belt

#130-77-002 #226 O-ring; Lower Seal; Qty: 2

#130-77-022 Rupture Disk; 33,000 PSI (227.5 MPa)

#130-77-080 Torsion Spring Module; F1

#130-77-1 Vee Jewel; Qty: 4

#130-77-2 Cell Assembly

#130-77-3 O-ring; 1.359" × .139"; NIT-C67; Qty: 4

#130-77-4 O-ring; 2" × 1⁄8"; VIT-V25; Qty: 4

#130-77-5 O-ring; 7⁄32" × 1⁄16"; NIT-C67; Qty: 8

#130-77-6 O-ring; 3" × 1⁄8"; VIT-V14; Qty: 4

#130-77-7 Stainless Steel Retaining Ring for 0.8125" Shaft; RS-81S;

Qty: 3

#130-77-91 Angular Contact Bearing

#130-77-10 3⁄16" Stainless Steel Ball; Qty: 2

#130-77-11 Shoulder Screw; 10-32 × 0.2495"; Qty: 2

#130-77-20 Rotor Bushing

#130-77-22 Upper Backup Ring; Qty: 3

#130-77-23 Lower Backup Ring; Qty: 3

#130-77-25 Test Stand Assembly

#130-77-15 Torque Magnet Assembly

#130-77-28 Drive Magnet

#130-79-04 DAQ Card for Desktop Computer

#130-79-05 DAQ Cable

#130-79-15 Serial Cable; OB9 M/F

#132-80 Calibration Fluid; 100 cP; 16 oz; Certified; Qty: 5

#152-37 AC Power Cord; 3-Conductor

#171-84-03 Strap Wrench
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Specifications
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Rotor / Bob Specifications

Rotor Radius, RR, (cm) 1.8415

Bob Radius, RB, (cm) 1.7245

Bob Height, L, (cm) 3.8

Shear Gap, (cm) 0.117

R Ratio, RB/RR 0.9365

Maximum Shear Stress (Dyne/cm2) 1680

Minimum Viscosity @600 RPM<a> (cP) 0.5<b>

Maximum Viscosity @0.01 RPM<c> (cP) 10,000,000

Shear Rate Constant, KR, (sec-1 per RPM) 1.7023

<a> Lower viscosities can be measured by the HTHP Viscometer, however one must take into account the effect of

bearing drag, Taylor vortices, zero offset, etc. when looking at the expected accuracy of the reading

<b> For practical purposes the minimum viscosity is limited to 0.5 cP due to Taylor Vortices

<c> Maximum viscosity is based on Maximum Shear Stress and Minimum shear rate (RPM).  However, due to prac-
tical and physical limitations, it may be difficult to take these measurements.

Instrument Geometry True Couette Coaxial Cylinder 

Motor Technology Stepper

Motor Speeds Variable: .006 - 1,000 RPM

Speed Accuracy .001 RPM

Shear Rate Range .01 - 1700 sec-1

Automatic Tests API Cementing and Mud Rheologies

Computer Requirements

DB-9 Serial Port, Windows 2000 or

XP.  Recommended screen resolu-

tion 1024 x 768 pixels.

There is considerable thermal lag within the test cell.  The temperature

sensor sits inside the thermowell in the rotor.  The test fluid surrounds

the sensor and the heaters surround the test fluid.  It can take several

minutes for the heat from the heaters to reach the innermost portions

of the rotor.  Therefore, the temperature reading in the ORCADA™ soft-

ware always lags behind the actual temperature of the test fluid.

Because of this, OFITE recommends only changing temperatures in

large increments (greater than 50°F or 10°C).  Making small adjust-

ments to the test temperature is unlikely to provide useful results.

�
Important

!



1. Connect the monitor, mouse, and keyboard to the computer and con-

nect the monitor and computer to an AC power outlet. The computer

and monitor were shipped with the appropriate power cords.

2. Turn the monitor and computer on. 

3. Connect the DB-9 cable to the viscometer and the computer COM port

1. This connection can be found on the right panel of the unit.

4. Connect the 68-pin cable to the viscometer and the computer. On the

unit, this connection can be found next to the DB-9 connection. There

will be a matching connection on the back panel of the computer.

5. Plug the viscometer unit into an AC power outlet and turn it on.

6. Run the ORCADA™ software by double-clicking the ORCADA™ icon

on the computer desktop. 

If this is a fresh install, you will be asked to select a hardware configu-

ration.  Select “Model 77” and click “OK”.  

7. From the Main Screen, click the “Utilities” menu and then click “Cali-

brate Shear Stress”.  To check if a signal is being transmitted from the

unit, simply observe if the value displayed in the “Temperature” field

corresponds to room temperature.
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1. Place the unit on a solid, level surface away from any large motors or

strong magnetic fields.  

2. The HTHP Viscometer is designed to test samples at elevated tempera-

tures and pressures.  It requires an air supply of 100 PSI (150 PSI

maximum) to drive the pump and a water source (standard tap water)

to cool the unit and the test sample.  The panel on the left-hand side of

the unit has 3 fittings, ¼" (6.35 mm) NPT, for the air supply, water

source, and drain.

3. Connect the DB-9 cable to the viscometer and the computer COM port

1. This connection can be found on the right panel of the unit.

4. Connect the 68-pin cable to the viscometer and the computer. On the

unit, this connection can be found next to the DB-9 connection. There

will be a matching connection on the back panel of the computer.

5. Make sure the viscometer power switch is in the “off” position. Connect

the power cord to the unit and an AC power source.

6. Turn the unit on. The power switch is located on the lower right panel.

Once the unit is turned on, you will immediately hear both fans operat-

ing inside the tower and a beep from the electronics.

Before running a test on the viscometer, you must zero the com-

pass and then run a calibration procedure.  For detailed instruc-

tions, see page 16 for calibrating the unit and page 45 for zeroing

the compass.
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Control Panel During a test, the computer will be continuously adjusting the pressure

inside the cell.  As the pressure increases due to thermal expansion, the

computer will allow pressure to bleed.  Likewise, if pressure begins to drop,

the computer will add pressure to keep it within the target range. 

The Regulator on the control panel controls the air pressure into the pump.

This should be set between 100 and 150 PSI (690 - 1,034 kPa) as indicat-

ed on the Air Pressure gauge.

Throttle Valve (Inside) - This valve gives you tighter control over the pres-

sure going into the pump.  Use this valve to fine-tune the pressure control

system.  To access this valve, remove the panel directly to the left of the

control panel.

When operating at the lower end of the pressure range (less than 10,000

PSI / 68.95 MPa), a single cycle of the pump could add far too much pres-

sure to the cell.  If this is the case, the throttle valve should be closed

slightly.  This will reduce the pressure to the pump, which will reduce the

amount of pressure added to the cell in each pump cycle.

When operating at the higher end of the pressure range (above 10,000 PSI

/ 68.95 MPa), a single cycle may not be enough to add pressure to the cell.

In this case, open the regulator slightly to increase the air supply to the

pump and increase the pressure added to the cell in each pump cycle.
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Operation 1. Remove the entire test cell from the heating well and place it in the

preparation stand.

2. Remove the cell and the cell cap from the coupling. 

3. Place a small amount of high-temperature thread lubricant (#165-44) on

all of the threads on the entire cell assembly.  This includes the bottom

threads for the test cell, the top threads for the cell cap, the threads on

the three ports, the threads on the bob and bob shaft, and the threads

on the screws holding the torsion spring module to the cell coupling.

4. Place an o-ring into the o-ring groove inside the cell, just above the rotor.

Carefully inspect all o-rings before use.  Replace any that show

signs of damage or wear.  O-rings are most likely to be damaged

after tests above 400°F (204°C).

5. Place the metal cell backup ring on top of the o-ring with the flat surface

facing up. 

The backup ring is designed to prevent o-ring extrusion.  Extru-

sion could cause the seal to fail or complicate the opening of the

cell after a test.  The backup ring is easily damaged and must be

handled carefully to avoid bending it. 

6. If the rotor is not already in the cell, carefully lower it in with the magnet

end at the bottom.

The easiest way to hold the rotor is to insert two fingers inside and

apply pressure outward.  Do not let it drop.
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7. Check the movement of the rotor.  To test for resistance, move a mag-

net or magnetized metal object around the outside of the cell at the

same level as the rotor magnet.  The rotor should turn freely inside the

cell as the outside magnet moves.  

If the rotor does not move freely, remove it from the cell.  Thoroughly

clean the rotor and magnet and inspect the bearing inside the outer

race on the rotor (see page 36).  Also check the rotor bushing for dam-

age or wear.

8. Pour 140 mL of test fluid into the cell.  

Be careful not to get any of the sample on the threads or seals.

The fluid level should be about 3⁄16" below the top of the rotor.

9. Check the movement of the rotor again (see step 7 above).  This will

help the test fluid fill the void space between the cell wall and the rotor.

10. Loosen the screws that attach the torsion spring assembly to the cou-

pling.  You should be able to lift the torsion spring assembly about ¼"

off of the coupling.  This slack will prevent damage to the jewel bear-

ings when tightening the test cell.

11. Slide the cell under the coupling and screw it into place.  

Watch the spring assembly closely as you turn the cell.  Just before the

cell tightens completely, the spring assembly should move up slightly.

This is caused by the pivot on the test cell inner race engaging with the

jewel bearing on the bob.  The pivot will push up on the bob and bob

shaft which are connected to the spring assembly.  

Once the spring assembly begins to move, stop tightening the cell.

Check the movement of the torsion magnet.  It should move up and

down slightly.  If it does not, the pivot may not have properly engaged

with the jewel bearing.  Unscrew the test cell and try again.

Once you confirm that the pivot has properly engaged with the jewel

bearing, finish tightening the test cell.  

If you feel resistance while screwing in the cell, stop immediately

and slowly unscrew it.  Never force the cell to tighten.  Make sure

the threads are lubricated with high-temperature thread lubricant

(#165-44).
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12. Place an o-ring into the designated groove on top of the coupling.

Place a metal seal ring on top of the o-ring.  Remember, the flat side of

the seal ring should face up.

Carefully inspect all o-rings before use.  Replace any that show

signs of damage or wear.

13. Tighten the screws on the torsion assembly to secure it to the coupling.

14. Set the pivot cap on the torsion assembly.  Make sure the bearing sits

on top of the pivot.

The magnet should not move from side to side.  If it does, carefully

tighten the screw on top of the pivot cap until you see the torsion

assembly move.  As soon as the torsion assembly moves, stop screw-

ing and loosen it a little.  You want to tighten the bearing just until it

engages with the pivot, no more.

15. Test the movement of the torsion magnet.  It should turn freely.

16. Screw the cell cap onto the coupling and tighten it completely.  

If you feel resistance while screwing in the cell cap, stop immedi-

ately and slowly unscrew it.  Never force the cell cap to tighten.

Make sure the threads are lubricated with high-temperature thread

lubricant (#165-44).

17. Inspect the heating well to make sure nothing has plugged the drain

holes around the temperature sensor which projects up in the center. 

18. Place an o-ring around the outer base of the coupling.  This will seal

the heating well and prevent steam from escaping during cooling.

19. Remove the cell from the preparation stand and carefully place it into

the heating well.  

The entire cell assembly is very heavy.  Be very careful when

removing it from the preparation stand.  Use both hands to avoid

dropping it.

20. Inspect the o-rings of the two port connectors on the test station for

damage and replace them if necessary.

21. Line up the inlet and outlet ports with the two pressure lines and tighten

the connections.  

The ports and pressure lines are designed to only line up one way.  If

they do not fit correctly, rotate the cell within the heating well until they

are in position.
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22. Tighten the cell locking screw to hold the cell in place during the test.

23. Swing the transducer housing around so that it rests above the test cell.

The distance between the bottom of the transducer housing and the top

of the tower should be 8.5" (22 cm).  If it is not, adjust the arm of the

transducer housing to raise it lower it to the correct position.

24. Fill a syringe with test fluid.  Inject 15 mL of the test fluid into the sam-

ple port.

This step is only necessary when testing drilling fluids to prevent solid

particles from damaging the o-rings.  If you are preparing the unit for a

calibration, you can fill the rotor up to the o-ring instead of injecting

addition fluid into the cell.

25. Inspect the o-ring on the sample port plug for damage.  Replace it if

necessary.  Screw the sample port plug into place and hand-tighten.  

26. Check the “Raw Signal” on the “Calibrate Shear Stress” screen.  The

value should be 350 ± 50.  See page 16 for instructions.

OFITE, 11302 Steeplecrest Dr., Houston, TX 77065 USA / Tel: 832-320-7300 / Fax: 713-880-9886 / www.ofite.com 11

�
Note

�
Note



OFITE, 11302 Steeplecrest Dr., Houston, TX 77065 USA / Tel: 832-320-7300 / Fax: 713-880-9886 / www.ofite.com 12

Software Start 1. Double-click the “ORCADA” icon on the desktop.

2. If this is a fresh install, you will be asked to select a hardware configu-

ration.  Select the appropriate device and click “OK”.  You will now see

the Main Screen.

3. The Windows XP firewall may try to block the ORCADA software from

communicating with the viscometer.  If the firewall shows the following

alert, select “Unblock”.

Available Tests

Manual Mode 

Controls
Analysis Data Process Variables

StatusLog Indicator
Communication

Indicator

Key

Main Screen

“Start Test” - This button starts a test in Auto Mode.  Once a test is start-

ed, this button becomes the “Abort Test” button.  Click here to stop the test.

“Cement” - This button performs a standard cement test based on API

specifications for analysis model RP 10B.

“Mud” - This button performs a standard mud test based on API Specifica-

tions for analysis model RP 13D.

Windows XP Firewall Alert
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Note:  The “Mud” and “Cement” tests ignore the “Dead Time” and “DAQ

Time” settings on the Options screen.  Temperature and pressure control,

which are disabled during custom Auto-Mode tests, are available during a

“Mud” or “Cement” test.

“Progress” - This button opens the Test Progress window, which shows all

of the steps of the current test and highlights the one currently in process.

“Status” - This box at the top of the screen shows the current status of the

test.

“Comm Timeout” - This light will be off when the PC is successfully com-

municating with the viscometer.  If communication is interrupted for any

reason, the light will shine red to indicate a problem.

“Start Logging” - This button is available in manual mode only.  Click here

to begin recording test data.  The light next to this button will shine green

while logging is in progress.  

“Cond Pause” - This button will pause a test during the conditioning phase

and put the software into Manual Mode.  While the test is paused, the

motor and heat controls can be controlled in the same manner as in a stan-

dard Manual Mode test.

To resume the test, click the “Cond Pause” button again.  You will be asked

if you want to “Continue” the test with the remaining conditioning time or if

you want to “Override” the remaining time and extend the effective condi-

tioning time.  If you choose to “Continue”, the time remaining in the condi-

tioning cycle will appear as though the test was never paused.  If you

choose to “Override”, the time remaining in the conditioning cycle will

resume at the point where the test was paused.



For example, assume a test has a conditioning time of 10 minutes and the

test is paused at the 5 minute mark for 1 minute.  If the test is unpaused

using the “Continue” option, the time remaining in the conditioning cycle will

be 4 minutes.  However, if the test is unpaused using the “Override” option,

the time remaining in the conditioning cycle will be five minutes, making the

effective total conditioning time 11 minutes.

“Raw File Save Period” - This field determines how often data is recorded

during a test.

“Experiment Name” - The entry in this field will be the file name for the

saved test data.  This field is required before starting a test in Auto Mode or

starting logging in Manual Mode.  Do not attempt to change the experi-

ment name during a test.

“Bob” - Select the type of bob currently being used in the unit.  An incor-

rect value in this field will adversely affect your test results.  This is the only

place where the bob selection can be changed.

“Key” - The checkboxes next to the graph key enable and disable graphing

of the indicated values.  For example, to exclude RPM from the graph,

uncheck the “RPM” box.  You can also customize the appearance of the lines

on the graph by clicking on the line example on the right side of the key.

“Manual Mode Controls” - The manual mode controls, in the bottom left-

hand corner or the screen, adjust the rotor speed, temperature, and pres-

sure while the unit is operating in manual mode.  

“Rotation” - This field determines the rotational speed.  The drop-down

box beneath the field set the units to either RPM or 1⁄s.

“Enable” - Place a check in this box to engage the motor.  Uncheck

the box to stop the motor.

“Temp” - This field determines the test temperature.  The drop-down

list beneath the field sets the units to either °F or °C.

“Enable” - Place a check in this box to enable temperature control.  If

the value in the “Temp” field is higher than the sample temperature, the

heaters will engage to heat the sample.
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“PreHeat” - This field is not used on the HTHP Viscometer. 

“Cool” - Place a check in this box to activate the cooling solenoid and

begin cooling the sample.  The value in the “Temp” field must be lower

than the sample for the software to initiate cooling. 

“Pressure” - This field determines the test pressure.  The drop-down

list beneath the field set the units to either PSI or kPa.

“Enable” - Place a check in this box to enable pressure control.  

“Prime” - Place a check in this box during initial pressurization.  This

function allows the cell to be pressurized without being interrupted by

the “Low Pressure Limit” (see page 21).  During initial pressurization,

the pressure will be below the “Low Pressure Limit”.  If “Prime” is not

checked, the test will be aborted immediately.

“Clear” - This button removes all data from the graph.

“Analysis Model” - This field, below the graph, displays the current Analy-

sis Model being used in the test.  This variable is set in the Test Builder

(refer to page 25 for more information).

“Analysis Data” - This chart shows the calculated values based on the

Analysis Model being used for the test.  This data will not display until after

the analysis sweep is completed.

“Temperature”, “Shear Stress”, “Viscosity”, “Shear Rate”,  “RPM” -

These fields display the current value for these variables.  They are display

only.  The drop-down box next to the “Shear Stress” field changes the units

of the Shear Stress variable.  The units can be set to: Dyne/cm2, lb/100ft2,

Pa., Dial Reading, lb/ft2
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The HTHP Viscometer is designed to be calibrated with certified calibration

fluids available from OFITE. These fluids are Newtonian silicone oils and

are available in a number of viscosities. The viscosity tables supplied with

the fluids are traceable to the National Institute of Standards (NIST). 

The viscometer will retain its calibration as long as the torsion spring Mod-

ule is not disassembled and is kept clean and corrosion free. Removing the

spring Cage Assembly from the top of the Coupling as a unit should have

only a minor effect on the mechanical zero. 

The ORCADA™ calibration program should be run prior to running any test

on the unit. It is suggested that a calibration should be performed when:

- The unit has been sitting unused for several weeks.

- The unit has been serviced.

- Periodically go into the “Calibrate Shear Stress” screen and check

the “Shear Stress Raw” value.  If the calibration signal drifts greater

than 50% from original setting, recalibrate.

The calibration fluid should be stored at room temperature and away from

direct sunlight. The shelf life of the calibration fluid is 2 years. The calibra-

tion fluid used during the calibration program should be checked for sus-

pended solids and clarity prior to being stored.  Cloudy calibration fluid

should be disposed of properly.

If you intend to re-use the calibration fluid, pour the used fluid into a clean,

sealable bottle for storage.  This will prevent the used fluid from contami-

nating the new fluid.  Then, for the next calibration, pour the used fluid into

the test cell and, if necessary, top off with new fluid.  Do not mix used fluid

with new.

The ORCADA™ software has an automated calibration program that will

work with calibration fluids of known viscosity. 

1. Turn on the power to the viscometer and let the unit warm up for

approximately 15 minutes.

2. Prepare for a test by following the instructions on page 8.  

3. From the main screen in the ORCADA™ software, choose “Calibrate

Shear Stress” from the “Utilities” menu. 

4. Notice the “Shear Stress Raw” reading, it should display a value of 300

± 50. If the signal reading does not fall within this range, the unit must

be zeroed for calibration.

To zero the unit, loosen the bolts on the transducer hood and rotate the

hood slightly while observing the “Shear Stress Raw” value.  When the

signal is within the acceptable range, tighten the bolts to secure the hood.

Calibration



5. Select a calibration fluid from the “Cal Fluid Batch” drop-down list.

Open the “Fluid Manager” and confirm that the settings match the data

sheet that was provided with the fluid.

If the list is empty, click the “Fluid Manager” button to add new fluid

batches.  Refer to page 20 for more information.

If the “Temp Out of Range” light shines red, the current sample temper-

ature is out of the specified range for the calibration fluid.  The sample

will have to be heated or cooled to be within the acceptable range

before calibration.

Do not attempt a calibration if the sample is not within the appro-

priate temperature range.

6. Choose a set of calibration rates from the “Rate Set”

drop-down list.

To create or edit a rate set, click the “Calibration

Rates” button.  To create a new set, click the “New”

button and enter a name and the rotational speeds.

To edit a set, select it in the “Rate Set” list, then

change the rotational speeds as necessary.

Due to mechanical limitations, calibrating at shear rates lower than

10 RPM is very likely to provide poor results.  OFITE recommends

calibrating in the same range of shear rates that you expect to test.

7. Click the “Start Calibration” button to begin the calibration.

Once the calibration has started, the software will begin filling in the

chart and plotting the results on the graph.

8. As the calibration proceeds, the software will begin to display the col-

lected data in the chart.  At the end of the calibration, the software will

calculate the “r^2” value, which measures the accuracy of the calibra-

tion.  If this value is less than 0.9990, recalibrate the unit.  

If this value is still low, remove the test cell and check the movement of

the rotor.  The rotor should turn freely.  If the unit still does not calibrate,

it will require servicing by an OFITE technician.

9. When the calibration is complete, check the r^2 value to make sure it is

greater than .9990.  If it is, click the “OK” button and enter a title for the

calibration.
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Rate Sets



“S.S. Reference” - the shear stress as calculated by the software

“S.S. Raw” - the actual signal coming from the unit

“RPM” - rotational speed

“Viscosity Reference” - the viscosity of the sample as calculated by the

software

“Temp” - the temperature of the sample

“S.S. Best Fit” - the line generated by the software to best fit the “S.S.

Raw” values

“Viscosity Best Fit” - viscosity value for a perfect calibration

“S.S. Fit Error” - deviation of actual shear stress from “S.S. Best Fit”

“r^2” - This is a measure of the accuracy of the calibration.  It will be cal-

culated at the end of the calibration cycle.  If this value does not read

greater than 0.9990 after multiple calibration tests, the unit will require

servicing. 

“r^2C” - The r^2 value only provides useful information when a calibration

is performed on a linear scale.  For non-linear scales, the r^2C shows the

corrected r^2 value and will provide a better measure of the accuracy of

the calibration.  For linear scales, the r^2 and r^2C values will be the

same.
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“Temperature” - the temperature of the sample

“Shear Rate” - rotational speed (1⁄s)

“RPM” - rotational speed (RPM)

“Shear Stress Raw” - the actual signal coming from the unit

“Ref Viscosity” - the viscosity of the sample as calculated by the software

“Ref Shear Stress” - the shear stress as calculated by the software
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Calibration
Fluid Manager

Before calibrating the unit, you must input the specifications of the calibra-

tion fluid that you are using.  This will give the software the information it

needs to perform the calibration accurately.

Click the “Fluid Manager” button on the Calibration screen to add a new

calibration fluid batch.

1. Click “New” to add a new batch.  You can also edit an existing batch

by selecting it in the “Batch Selector” list.

2. In the “Batch” field, type a name for the batch.  OFITE recommends

using the lot number and viscosity from the Certification Chart that

was provided with the fluid.

3. In the “Calibration Fluid Table”, enter at least two Temperature/Vis-

cosity pairs from the Certification Chart.  Only two pairs are

required.

The “Table Linearity Error” light will shine red if the values in the

“Calibration Fluid Table” do not create a straight line.  If this occurs,

check the values and re-enter them.

4. Once you have entered all the batches, click “OK” to close the Fluid

Manager and return to the Calibration screen.
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Software
Options

To access the Options screen, choose “Options” from the “Edit” menu.

“Pressure Minimum Deadband” - During testing, the pressure inside the

test cell is likely to increase due to thermal expansion.  When the pressure

rises too high, the software bleeds off the excess.  If the pressure drops too

low, the software increases the pressure.  The software calculates the

threshold by adding 3% of the setpoint to the value in the “Minimum Pres-

sure Deadband” field.

For example, assume the pressure setpoint is 10,000 PSI and the “Pres-

sure Minimum Deadband” is set to 100.  The threshold in this scenario is

400 (10,000 × .03 + 100).  Therefore, if the pressure increases to 10,400

PSI, the software will open the pressure release valve and bleed off the

excess.  And, if the pressure drops below the setpoint (10,000 PSI), the

software will engage the pump to increase the pressure.

“Low Pressure Limit” - This field determines when a test will be aborted

due to low pressure.  If the pressure drops more than the value in this field,

the unit will automatically turn off the pump and the heater to avoid damag-

ing the equipment.  The value in this field is relative to the operating pres-

sure.

“One Heater / Two Heaters” - The heater switch adjusts the heater PID

controller to change whether the unit is using one or two heaters to set the

test temperature.  Switching from two heaters to one can be useful at lower

temperatures (generally less than 325°F / 163°C) because it provides more

control over the temperature range.  This function should be used with the

“Heaters” switch on the front control panel of the unit.  

“Precision Stop Mode” - The HTHP Viscometer measures shear stress

by reading the position of the magnets that turn the rotor.  When the rotor

stops, if the magnets are not centered at their origin position, the shear

stress reading in the ORCADA software will not read 0.  The precision stop

addresses this by stopping the rotor with the magnets centered in their ori-

gin positions.  Instead of an immediate stop, the rotor is first slowed so that

it can be more accurately stopped at the origin.

“None” - Never perform a precision stop.

“Gel Only” - Only perform a precision stop before a gel test.

“Always” - Perform a precision stop every time the rotor is stopped.

This setting is recommended.

“Precision Stop RPM” - This field sets the speed of the rotor during a pre-

cision stop.  A lower value here will produce more accurate results, but the

rotor will take more time to come to a complete stop.  A higher number will

stop faster, but will provide less accurate results.  3 RPM is recommended.



“Enable Auto Cool” - Check this box to have the viscometer automatically

cool the cell after a test.

“Deactivate Cooling when Temp within X°C of Setpoint” - This value

tells the software to stop cooling the cell when the temperature is withing a

certain range.

“Deactivate Cooling when Temp is less than” - This value sets a mini-

mum temperature for cooling.

“Enable Shear Stress Cutoff” - This feature is designed to protect the

internal components from excessive shear stress.  Check this box to

enable the feature.

“Shear Stress Cutoff (%)” - Enter a percentage of the maximum shear

stress for the unit.  The maximum shear stress is 300 DR.  Therefore, a

value of 70 in this field will stop the viscometer at 210 DR.

“RPM DAQ Settings” - “RPM High”, “RPM Med” and “RPM Low”, “Dead

Time”, “DAQ Time”.  These fields are used to determine the amount of

time needed for the sample to stabilize at a given rate.  The fields are also

used to determine the amount of time data is averaged before being

saved.  For example, if RPM High is set to 60, Dead Time is set to 15 and

DAQ Time is set to 20, any rate of 60 RPM or greater during a sweep

would stabilize for 15 seconds then begin averaging data for 20 seconds

before saving the data.

“Com Port” - This field specifies which Com port the viscometer is con-

nected to.

“DAQmx Device Name” - If multiple DAQ cards are installed on the PC,

choose the card you wish the unit to use.

“Slave ID” - If multiple units are being monitored through the ORCADA™

Software, each one must be identified by a unique “Slave ID”.

“Reverse Rates Gel UI” - If “Hystoresis” is selected on the “Test Builder”

screen (see page 25), this option will perform a gel test after the forward

portion of the sweep and after the backward portion.

“Data Archive Directory” - This field specifies the directory to store

archived data.
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“Wait for Temp Mode” - If a step in the test is set to wait for the tempera-

ture setpoint, this option will control how the software determines if the tem-

perature has reached the setpoint.

“Temp Reaches Threshold” - If this option is selected, the software

will stop waiting on the setpoint as soon as the temperature is within

the threshold.  The threshold value is set in the Test Builder.

“Temp is Stable Within Threshold” - If this option is selected, the

software will stop waiting on the setpoint only when the temperature

has stabilized within the threshold.
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Software
Save Rate Settings

By default, the ORCADA™ Software saves data to file based on a set time

interval.  This time interval can be changed by editing the “Raw File Save

Period” field on the main screen.  However, the “Save Rate Settings” fea-

ture provides more control over data save points.  The software will monitor

each selected variable and record a data point to the file when that variable

changes by the amount specified. 

1. Select “Save Rate Settings” from the “Edit” menu. 

2. Place a check mark next to each variable you wish to monitor.

3. In the field after the variable name, enter the variance required to initi-

ate a save point.

For example, if you want the software to record a data point when the

temperature increases or decreases more than 5°, place a check next

to “Temperature” and enter 5 in the field next to it.

4. Click “OK” to save the settings and return to the main screen.

“Elapsed Time” - seconds since the start of the test

“RPM” - rotational speed (RPM)

“Shear Rate” - rotational speed (1⁄s)

“RPM SP” - rotational speed setpoint

“Temperature” - measured sample temperature

“Temp SP” - temperature setpoint

“Temp Duty Cycle” - the frequency (in seconds) the

heaters engage to increase the temperature

“Viscosity” - measured viscosity (cP)

“Shear Stress” - measured shear stress

“Shear Stress Tare” - change in measured shear stress

“Pressure” - measured pressure

“Pressure SP” - pressure setpoint
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Software
Test Builder

The Test Builder is designed to help you build custom tests for use in Auto

mode.  To access the test builder, go to the Main Screen and choose “Test

Builder” from the “Edit” menu. 

1. To create a new test, click the “New Test” button.  To create a new

test based on one of the “RP 10B”, “RP 13D”, or “RP 39” analysis

models, click the appropriate button at the top of the screen to open

a template.  To edit an existing test, select the test from the list in

the upper left-hand corner of the screen. 

2. Enter a name in the “Test Name” field.

3. Choose an Analysis Model.

a. “RP 39” - Power Law Model - records the Power Law calcula-

tions (n and k)

b. “RP 13D” - Bingham Plastic Analysis Models - records plastic

viscosity (PV) and yield point (YP)

c. “RP 10B” - Power Law and Bingham Plastic Models combined

4. Input the values for your test into the fields in Record 1.

a. “Heat Time” - the time it will take the unit to heat the sample to

the temperature setpoint.  If this field is left blank, the unit will

heat the sample as fast as possible.

b. “Heat RPM” - the rotational speed during the heating period

c. “Temp” - the temperature setpoint.  Enter any letter in this field

to indicate “Ambient”.

RecordsAvailable Tests

Test Detail



d. “Pressure” - the pressure setpoint

e. “Cond. Time” - the time period to condition the sample

f. “Cond. RPM” - the rotational speed during conditioning

g. “#/Swps” - the number of sweeps to perform after conditioning.

A sweep is a set of rotational speeds separated by time interval.

Between sweeps, the rotor returns to the Cond. RPM.  At the

end of each sweep, the unit calculates the Analysis Model val-

ues.

h. “Delta Time” - the time interval between sweeps

i. “Gel Time 1” - During a gel time interval, the rotor comes to a

complete stop and waits.  At the end of the interval, the rotation-

al speed is increased to 3 RPM until the gel breaks and a gel

strength value is recorded.  Click the “Insert Gel Column” button

to add a gel time to the record. 

j. “RPM 1, 2, 3, etc.” - The RPM fields set the speed of each step

of the sweep.

5. Repeat step 4 in the following record fields until you have complet-

ed building your test.

6. Click the “OK” button to save the test and return to the main screen.

“Hold for Temp” - Click this checkbox to tell the unit to wait until the sam-

ple has reached the temperature setpoint before proceeding to the next

step.  If this box is unchecked, the test will proceed while the sample is

heating.

“Temp Threshold” - This field specifies an acceptable variance on the

temperature.  For example, if the temperature setpoint is 150° and the

“Temp Threshold” is set to 5°, the software will consider the setpoint

reached when the temperature is between 145° and 155°. 

“Temp Unit” - set temperature units to either °F or °C

“Rate Unit” - set the rate units to either RPM or 1⁄s

“Pressure Unit” - set the pressure units to either PSI or kPa

“Hystoresis” - If this box is checked, each sweep will be performed for-

ward and backwards.  

“Stir Parameters” - These parameters only apply if the test includes a gel

time.

OFITE, 11302 Steeplecrest Dr., Houston, TX 77065 USA / Tel: 832-320-7300 / Fax: 713-880-9886 / www.ofite.com 26



“Stir Prior to Gel” - Check this box to stir the sample before calculating

gel strength.

“Gel Stir Rate” - This is the rate the sample will be stirred prior to calculat-

ing gel strength.

“Gel Stir Time” - This is the time interval the sample will be stirred.

“Plot All Records” - If this box is checked, all records will be plotted on

the graph.  If it is not checked, only the currently highlighted record will be

plotted.

The graph below the records provides a visual representation of the current

test.  Each line represents one aspect of the test: RPM Setpoint, Tempera-

ture Setpoint, Pressure Setpoint, and Temperature PV.  Refer to the key to

the right of the graph for details.

The graph features a cursor, a vertical yellow line, that can be used to view

more detailed information about the different phases of the test.  The “Cen-

ter Cursor” button moves the cursor to the center of the graph.  Click and

drag the cursor across the graph to see more detailed information.  Refer

to the “Test Detail” field below the graph for more information. 
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Software
Select Analysis

Outputs

After building a test in the Test Builder, the chart at the bottom of the Main

Screen will show the various data points being calculated by the viscometer

based on the chosen Analysis Model.  This chart, however, is customizable.

You can choose which data points are displayed on the chart and which

are not.

From the “Edit” menu, choose “Select Analysis Outputs”.  By default, all

data points are selected and will appear on the chart.  To remove a data

point from the chart, simply uncheck the box next to it.
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Software
Saved Test Data

To review test data from past tests:

1. Select “Saved Test Data” from the “File” menu.

2. The saved test data is grouped by month.  Select the folder for the year

and month of the data you are looking for and click the small + sign

next to it.  This will show you all of the data for tests run that month,

including any comments you added.

3. Select the test you are looking for and click the “OK” button.  Multiple

tests can be selected by holding down the CTRL key and selecting

each test.

4. On the “Raw Data” tab you will see the graph of the test results.  The

“Analyzed Data” tab shows the results of the calculations based on the

Analysis Model.  The “Test Setup” tab shows the parameters of the test.

Saved Experiment Explorer

Raw Data
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“Export” - Click this button if you wish to export the test data to a file.  You

will be asked to select a filename and destination and then click “OK”.  The

resulting file can then be opened in Microsoft® Excel for further analysis.

“Print” - Click this button to print the results to the default printer.

“Experiment Explorer” - Click this button to choose another set of test

data to review.

“OK” - Click this button to return to the main screen.

Analyzed Data

Test Setup
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Software
Calibration History

On the Calibration History Screen, you can retrieve the data from all past

calibration tests.

1. Begin on the Main Screen.  Select “Calibration History” from the “Utili-

ties” menu.

2. The calibration tests are grouped by month.  Select the folder for the

year and month of the calibration test you are looking for and click the

small + sign next to it.  This will show you all of the calibration tests run

that month, including the fluid batch and any comments you added after

the test.

3. Select the test you wish to view and click the “OK” button.

4. You can now see the graph, chart, and fluid batch details.

5. Click the “Export” button if you wish to export the calibration results to a

file.  You will be asked to select a filename and destination and then

click “OK”.

6. When viewing a calibration, you can click the “Make this Cal Active”

button to activate the calibration and apply it subsequent test data.

Calibration History Explorer

Calibration History
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Software
Import/Export

The Import/Export feature of the ORCADA™ Software makes it possible to

transfer a test from one PC to another.

1. Begin on the Main Screen.  Choose “Export” from the “File” menu.

2. Select the tests you wish to export.  Hold down the CTRL key to select

multiple tests.

3. Click the “Export” button.  You will be asked to choose a destination

and filename and then click “OK”.

4. Copy this file to the destination PC.

The file must be placed in the correct folder for it to be available for

import.  To find this folder, first navigate to the folder specified in the

“Data Archive Directory” field in the Options screen (see page 21 for

details).  From there go to the “ORCADA” folder and then the “Tests

Import Export” folder.

5. On the destination PC, choose “Import” from the “File” menu.

6. Choose the tests you wish to import.  Hold down the CTRL key to

select multiple tests.

The “Export” field lists all of the files that are available for import.  Once

you have selected one, the “Tests” field shows which individual tests

can be imported from that file.

Below the “Export” and “Tests” fields is a display-only field that shows

the folder being scanned for exported tests.  Make sure the tests you

want to import have been placed in that folder.

7. Click the “Import” button.  The new tests will appear in the list in the

upper left-hand corner of the Main Screen.

Export Import



Software
Starting a Test

The ORCADA™ software has two modes for running tests: Auto and Man-

ual.  By default, the software is in Manual mode when first opened.

To begin a test in Manual mode:

1. Enter a value in the “Rotation” field and choose a setting for units

(RPM or 1⁄s).

2. Select the “Enable” checkbox next to the “Rotation” field to start the

motor.  

Once the motor is started, the display fields on the right-hand side

of the screen will begin displaying test data.

3. Enter a temperature in the “Temp” field and choose Celsius or

Fahrenheit.  

If you are testing at lower temperatures (generally less than

250°F/121°C) it may be more difficult to reach and maintain the

desired temperature.  If you experience this problem, use the

“Heater” switch on the unit control panel to choose only one heater.

You will also need to change this setting in the “Options” screen

(see page 21 for details).

4. Select the “Enable” checkbox next to the “Temp” field to start the

heater.

The “Cool” option activates the cooling solenoid and brings the tem-

perature down to the value specified in the “Temp” field.  The “Pre-

Heat” field is not used on this viscometer.

5. Enter a name in the “Experiment Name” field and click the “Start

Logging” button.

6. Enter a comment in the resulting dialog box.  Comments are option-

al, but can be used later to identify the test results.

To begin a test in Auto mode:

1. Choose a test to run from the list in the upper left-hand corner of

the Main Screen.

2. Enter a name in the “Experiment Name” field.

3. Click the “Start Test” button.

4. Enter a comment in the resulting dialog box.  Comments are option-

al, but can be used later to identify the test results.
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In order to keep the HTHP Viscometer in good working condition, proper

cleaning and maintenance are essential.  After each test, immediately

remove the test cell and rotor and clean them thoroughly to avoid corrosion

and caking.  

During high-temperature tests, the test fluid may expand up into the torsion

assembly.  After each test, inspect the torsion assembly and the bottom

jewel bearing for test fluid.  Also, check the rotor bearing for any residue.  If

any is present, clean the parts thoroughly, preferably with a small ultrasonic

cleaner.

Select a cleaning solution based on the test fluid.
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Maintenance



Before releasing the pressure in the test cell, make sure it has cooled to

150°F (65.5°C) or less.  The cell should be cooled to 100°F (37.8°C) or

less before handling to prevent injury.

1. Unscrew the port connectors from the test cell. Leave the sample port

plug in place. Some pressurization fluid may leak from the left (inlet

pressure) connector.

2. Carefully remove the test cell from the heating well and place it on the

preparation stand.  Lock it in place with the locking pin.

3. Unscrew the cell and set it below the bob to catch the drips. The strap

wrench may be required to beak it loose.   

4. Pour out the contents of the cell and allow it to drain.  Be sure to catch

the rotor if it falls out.

5. Remove the rotor from the cell and set it down (magnet side up) to

drain.  Make sure there are no magnetic materials nearby.  Disassem-

ble the rotor when it has finished draining.  (See page 36)

The drive magnet is highly magnetic and very brittle.  Extreme

care should be taken to prevent the magnet from being inadver-

tently attracted to another magnet or to any ferrous object.

The magnet should also be kept away from sensitive mechanical

devices such as wrist watches and meters.  Magnetic data record-

ing media like computer disks and tapes, and credit cards should

also be kept well away.

6. Remove the backup ring and o-ring.

7. Place all of these components into a sonic bath until clean. 

Be sure to keep the magnets separate from the other components

to avoid damage.  
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Disassembly
Cell



1. Using a flat-head screwdriver, remove the two screws on the bottom of

the rotor and remove the magnet holder.  

2. Push the rotor bushing out of the bottom of the magnet holder. 

3. Remove the magnet and place it on a non-magnetic surface. 

Keep magnetic objects away from the magnet.

4. Place all of the parts in a cleaning solution or ultrasonic cleaner and

clean them thoroughly. The drive magnet should be cleaned separately.  

Be sure to keep the magnet separate from the other components

to avoid damage.  
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Rotor

Disassembly
Rotor

Magnet

Magnet Holder

Magnet Holder

Rotor Bushing

Magnet 
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5. The rotor should be further disassembled by removing the rotor bearing.  

a. Using a small punch, press the rotor bearing out of the middle of

the rotor.  

b. Thoroughly clean or replace the rotor bearing. 

c. Use a brush to clean the small bore of the rotor.
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1. Unscrew the cell cap and remove it. The strap wrench may be required.

2. Lift the pivot cap off of coupling.  This will expose the upper torsion

magnet.

3. Grasp the bob and unscrew (clockwise) the bob and bob shaft from the

torsion assembly at the top.  Unscrew the bob from the bob shaft and

place them in cleaning solution.  

A small stiff brush and a wash bottle filled with a suitable solvent are

useful tools when cleaning these parts. Be sure and run a brush

through the bob shaft to clean the bore. 

4. Remove the two screws that hold the torsion spring module to the cou-

pling. Place the torsion spring module into the cleaning solution. This

module must be cleaned carefully. Make sure that any caked solids in

and around the limit stop and the torsion spring are removed. A jet of

cleaning solution is useful for this. 

The torsion assembly may have to be disassembled in order to com-

pletely clean out caked solids on the spring assembly.  Remember to

calibrate after re-installing the assembly.

5. Use the torsion magnet to lift the stainless steel ball from the coupling.

Keep the ball on the magnet so that it will not be lost.  This ball acts as

a check valve to prevent pressurization fluid from returning back to the

pump.
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1. Remove the baffle.  It may be necessary to put a small screwdriver or

allen wrench through the holes in the baffle to loosen it.

2. Remove the sample port plug from the coupling and clean it with a

small brush in the cleaning solution.  Inspect the o-ring and replace it if

it is damaged or worn.

3. Remove the coupling from the stand and clean it thoroughly.  Use a

brush to clean all holes, crevices, and threads.  Set the coupling on its

side rather than on its ends. 

Be careful not to scratch the top and bottom surfaces of the cou-

pling while cleaning, since they are sealing surfaces.  

4. Rinse the coupling and use an air jet to dry it. 
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Disassembly
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�
Important
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Sample Port

Pressure Outlet

Pressure Inlet

Stainless Steel Ball

Baffle



1. Remove the rotor from the test cell.

2. Try to fit the new bearing onto the thermowell.  If bearing is too tight,

use sand paper or emery cloth to sand down the shaft until the bearing

goes on and off smoothly. 

3. Remove the magnet and magnet holder from the rotor.

4. Using a flathead screwdriver and hammer, tap the pivot bearing until it

falls out.

5. With the bearing installer, firmly push the new bearing all the way into

the rotor. 

6. Reassemble the rotor.
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Remove/
Install

Angular Contact
Bearing

Pivot Thermowell

Bearing

Pivot Bearing Bearing Installer



Remove/
Install

Pivot Bushing

Removal:

Once the angular contact bearing inner race is removed, the pivot bushing

can also be removed with the puller and the slide hammer. 

1. Screw the puller onto the threaded end of the slide hammer. 

2. Remove the two inner race adapters from the ends of the arms, if they

are installed. 

3. The circular slot in the fittings at the end of the arms is designed to

engage the flange at the bottom of the bushing. Separate the arms of

the puller a little and lower them to the bottom of the cell, around the

pivot/thermowell.  

4. Close the arms of the puller, engaging the slots on the bushing flange

on each side. 

5. Hold the arms closed with one hand and slide the weight of the slide

hammer up with the other, banging it against the stop away from the

cell. After a few moderate blows, the bushing should break loose. 

Installation:

1. Drive the pivot bushing into position by striking the stop closest to the

cell with the slide hammer weight. 

Do not use any locking compound when installing the bushing. 

2. Make sure it is driven all the way down.  Check this by putting the rotor

in the cell and confirming that the ball bearing is supporting it, and not

the bushing at the bottom. If it is not all the way down, the uplifted rotor

will push against the bob when the test cell is assembled, preventing

proper rotation of the bob.
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Remove/
Install

Rotor Bushing

Removal:

Refer to page 36 for instructions.

Installation:

1. Set the rotor cup down with the open end down. 

2. Set the magnet holder on the rotor with the slotted end down. 

3. Rotate the magnet holder until the two screw holes line up with the cor-

responding holes in the rotor. 

4. Apply a small amount of high-temperature thread lubricant to the end of

the two screws before screwing them in place.

5. Slide the drive magnet into the slot until it is roughly centered. 

6. Push the rotor bushing into the hole in the magnet holder and into the

drive magnet until it stops. This helps to temporarily retain the magnet. 

7. Visually center the drive magnet so that it does not protrude more on

one side than the other and tighten the set screw in the magnet holder.

This will lock the drive magnet into position. 
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Magnet Holder

Rotor Bushing

Set Screw

Magnet 



Removal:

1. Slide the pivot cap off of the torsion assembly.

2. Unscrew the two screws that secure the torsion assembly to the cou-

pling and remove the assembly from the coupling.

3. Loosen the set screw on the torsion magnet and remove the magnet

from the spring assembly.

4. Loosen the set screw on the zeroing sleeve and slowly pull the spring

assembly down and out of the spring housing.

Do not stretch the torsion spring.

5. Loosen the set screw on the spring cage and remove the zeroing

sleeve.

6. Place all of these components into a sonic bath until clean.
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Torsion Spring Assembly (#130-77-080)
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Installation:

1. Slide the zeroing sleeve into the spring housing and tighten the set

screw to secure it in place.

2. Slide the spring assembly up through the spring housing and secure it

in place by tightening the set screw on the zeroing sleeve.

3. Slide the torsion magnet over the pivot and onto the spring assembly

and secure it in place by tightening the set screw.

4. Look for the groove on the bottom of the spring housing.  Line up this

groove with the stainless steel ball on the coupling.  Set the torsion

assembly on top of the coupling.

5. Secure the torsion assembly with the two screws.
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Appendix
Zeroing the Compass

The compass, inside the transducer housing, tracks the movement of the

spring assembly by measuring the magnetic field of the upper magnet.

The natural magnetic field of the Earth will interfere with this process

unless the orientation of the compass is established and recorded.

You must zero the compass any time the HTHP Viscometer is moved.

1. Load the test cell and position it as you would for a test.  See page 8

for instructions.

2. Remove the eight locking screws from the transducer housing.

3. Position the transducer housing so that the screw hole in the base is

aligned in the center of the screw notch in the cap.  This will give you

the most room for adjustment.

4. Remove the cell cap and pivot cap to expose the magnet on the torsion

assembly.

5. Loosen the set screw on the torsion spring magnet.

6. Open the ORCADA software and select “Calibrate Shear Stress” from

the “Utilities” menu.

7. Observe the value in the “Shear Stress Raw” field.  Turn the torsion

magnet until this value is between 0 and 50.

The sensor in the compass is very sensitive.  Turn the magnet very

slightly and then wait for the signal to stabilize before continuing.  If you

turn the magnet past zero, the display will show 8000.  Simply turn the

magnet back the other way until the value is back on target.

8. Tighten the set screw to lock the torsion magnet in place.
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9. Place the pivot cap back onto the torsion assembly and place the cell

cap back onto the test cell.

10. Unplug the serial cable from the ORCADA port and plug it into the com-

pass port.

11. On the PC, load the C100 software.

12. Press “S” to enter the “Setup” screen.  Using the “Tab” and arrow keys,

set the “Port” value to “COM1” and the “Baud” value to “4800”.
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4800 BaudCOM 1

Compass Port

ORCADA Port DAQ Port



14. Next, press “C” to enter the “Calibration” screen.  Choose “Eight Point”.

15. Follow the on-screen instructions.

The software will prompt you to turn the cap 45° and then press the

space bar.  After doing this eight times, the software will display a cali-

bration score.  If any errors occurred, follow the on-screen instructions

to correct them.

16. Once the calibration is complete, press “Q” to exit the software.

17. Return the cap to the zero position and lock it in place by tightening the

locking screws.

18. Be sure to switch the serial cable from the compass port back to the

ORCADA port.
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Output Format: 2

Baud Rate: 4800

13. Press “P” to enter the “Parameters” screen.  Wait for a few seconds

while the PC communicates with the viscometer.  Once the software fills

in the fields, use the “Tab” and arrow keys to set the “Analog: Output

Format” value to “2”.



Appendix
Reinstalling Software

Reinstallation of the ORCADA™ and data acquisition software packages

will only be necessary in the case of computer replacement or catastrophic

failure in the current computer system.

NI-DAQ Software:

1. Physically remove the DAQ card from the computer's PCI slot.

2. Turn on the computer and place the NI-DAQ CD in the drive and 

wait for it to start up. When ready, install the NI-DAQ software. If the

software asks you for the “device” being installed, it is “PCI 6024E”.

3. When the install program stops and asks you if you want to reboot the

machine, or shut down manually, choose to shut down manually. Do

not remove the CD.

4. Shut down the computer, and reinstall the DAQ card.

5. Start up the machine again, and you should see the computer find the

card and load drivers for it. The install package will start up again and

finish the install.

6. When the installation is complete, confirm that the software is installed

properly and that the card is working:

a. Start up the DAQ program called “Measurement and Automation”. 

b. Under the “Configuration” window, you will see a tree structure.

Under “My System”, open the “Devices and Interfaces” node and

then select “NI-DAQmx Devices”. 

c. You should see a device listed as DAQ-6024E (Dev1).  Right-click

on this and select “Self Test”.  This should respond that the device

has passed the test.

If the self test fails, right-click the device again and select “Restart

Device”.  Run the self test again.  If the self test fails again, return

to step 1 and try a different PCI slot in the computer.  If the device

still does not work, the system will need to be replaced.

ORCADA Software:

1. Place OFITE CD or startup floppy into appropriate drive.

2. Double click on “Setup.exe”. (The program is self-installing).

3. Follow the instructions to install the program.

4. Once complete, copy the icon to the desktop if desired.
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Temperature Pressure

°F °C PSI kPa

Ambient - 200 Ambient - 93.3 0 0

201 - 295 93.9 - 146.1 100 690

296 - 355 146.7 - 179.6 200 1,380

356 - 395 180.1 - 201.8 300 2,070

396 - 445 202.4 - 229.6 500 3,450

446 - 500 230.2 - 260.2 800 5,520

Appendix
Minimum Required

Pressures



Appendix
Conversion Charts
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Viscosity Conversions
To convert from units on left side to units on top, multiply by factor @ intercept.

Centipoise

(cP)

Poise

(P)
g/(cm × s) (mN × s)m2 mPa × s

(lb × s)

100 ft2

Centipoise 1 0.01 0.01 1 1 0.002088

Poise 100 1 1 100 100 0.2088

g/(cm × s) 100 1 1 100 100 0.2088

(mN × s)m2 1 0.01 0.01 1 1 0.002088

mPa × s 1 0.01 0.01 1 1 0.002088

lb × s

100 ft2
478.93 4.789 4.789 478.93 478.93 1

From

To

Rotation Conversion

RPM sec-1 or 1⁄s

1 1.70

2 3.40

3 5.11

6 10.21

10 17.02

20 34.05

30 51.07

60 102.14

100 170.23

200 340.46

300 510.69

600 1021.38

1000 1702.30



Appendix
Test Cell Assembly
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Rotor

(#130-77-38)

Bob Shaft

(#130-77-43)

Coupling

Port Adapter

(#130-77-36)

Cell Cap

Jewel Bearing

(#130-77-1)

Torsion Spring

Rotor Bushing

(#130-77-20)

Bob (#130-77-39)

Jewel Bearing

(#130-77-1)

Baffle (#130-77-41)

Stainless Steel Ball

(#130-77-10)

Torsion Magnet

Pivot Cap 

(#130-77-46)

Magnet Holder

(#130-77-40)

Rotor Magnet

Test Cell



Appendix
Test Cell Assembly -

Exploded
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Coupling

O-ring (#130-77-5)

(Not Shown)

Pivot Cap 

(#130-77-46)

Pivot 

(#130-77-12)

Jewel Bearing

(#130-77-1)

Rotor (#130-77-38)

Angular Contact

Bearing (#130-77-91)

Rotor Magnet

Rotor Bushing

(#130-77-20)

Pivot 

(#130-77-12)

Bob Shaft

(#130-77-43)

Torsion Assembly

Cell Cap

Baffle  

(#130-77-41)

Bob (#130-77-39)

Jewel Bearing

(#130-77-1)

Test Cell


